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Slide One - Title slide 

EndNote Reference Management Software: Introductory I: Getting to know the software 

Before we begin: 

This is one in a series of workshops around EndNote 

They range from introductory level (Introductory I) up to intermediate level (Intermediate 

II) 

Taken together, they will cover the main points you need to know in order to use the 

software 

We can’t fit everything you need to know in a single workshop, so sign up for the others, 

look at the PPTs / transcripts for further information 

 

Slide Two - Session Content 

•  Where to download EndNote 

• How to create your library 

• The ‘look and feel’ of EndNote 

• Help & further information 

This introductory session will not be looking at how to use EndNote – it will focus on 

finding and downloading the software, and then will go through the main features which 

you are likely to want or need to use. 

Future workshops will cover how to use EndNote, so look at the session content list on 

the booking page for each workshop to see what will be covered in which session, to 

make sure that you sign up for the session you need. 
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Slide Three - Learning Outcomes 

By the end of this session, you should: 

• Know where to find EndNote to download it 

• Understand the process of creating a library and setting up your preferences so 

that you’re ready to use EndNote 

 

Slide Four - Getting Started: Download EndNote 

All members of the University of Derby get free access to the full version of the EndNote 

Reference Management Software to use on their own devices.  

This will only be available for the duration of your programme so, if you want to preserve 

your library content to use after you’ve graduated, you will need to make sure that you 

have exported your library in a format compatible with the reference management tool 

you will use later. 

This will be covered in a later session so don’t worry if you don’t remember this later – 

you will be reminded. 

 

Slide Five - Start in Course Resources  

•  Log into UDo and go to the home page for Course Resources. 

•  On that page, look for a link which says, Software Downloads, and click on it.  

You will then see a page with a short list of software that you are able to download on 

your personal device as long as you’re a member of the university. 

 

Slide Six - Downloading EndNote 

 Click on the EndNote link to start the software download.  



Introductory I Transcript   20 September 2023 
Jill Boland  University of Derby Library 

 5 
 

There are instructions from DS&S (formerly IT Services) on how to install EndNote onto 

your device, so that process will not be covered here.  

If you find that you are having trouble installing EndNote onto your device, or that you 

are getting error messages, remember to contact IT Services for help, either by visiting 

the website, via email or by going to the help desk in ‘B’ Block, on the second floor.  

 

If, after installing the software, you have difficulties using EndNote – either inputting 

data, or exporting references to a Word document, please contact the library for advice, 

either by emailing library enquiries, or via the online chat – look for the chat bubble on 

the bottom right of any library web page. 

 

Slide Seven - Warnings! 

• Make sure you keep your EndNote Library on your hard drive – don’t move it to 

the cloud. Moving the folders to a cloud-based storage system can lead to file 

corruption…so you would basically have to start all over again! 

• There are two parts to each library – a data folder and your EndNote library file. If 

you separate the two files, then your library won’t work so make sure you keep 

them together. 

• Try to give your library a meaningful name to make it easier to find – otherwise 

EndNote will use the default, ‘My EndNote Library’. If you create more than one 

library, and you can, you don’t want them all to be called different versions of ‘My 

EndNote Library’ 

 

Slide Eight - EndNote libraries on your device 

One file will have your library’s name with a suffix of .Data e.g., Research Library.Data 

and the icon will be a yellow folder. In the File Type column it will say, ‘File Folder’. 

http://www.itservicentre.derby.ac.uk/
http://www.itservicentre.derby.ac.uk/
mailto:itservicecentre@derby.ac.uk?subject=Trouble%20with%20downloading%20/%20installing%20EndNote
mailto:library@derby.ac.uk?subject=Trouble%20using%20EndNote%20reference%20management%20software
https://libguides.derby.ac.uk/home
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The second file will just have the name of your library e.g., Research Library and the 

icon will be the purple and white EndNote icon. In the File Type column it will say, 

‘EndNote Library’. 

Think of your library file as a filing cabinet, and the data file as the contents of that 

cabinet. 

 

Slide Nine - Opening / Creating a library 

This slide has a screenshot of the EndNote dialog box which appears when you open 

EndNote – it gives you the option of opening an existing library, or creating a new one. 

• Find EndNote in your programme files and open it up (in Windows this will be 

under the Windows logo button where it displays a list of programs you 

can access – it may also have been added to Start) 

• When you click on the link to open EndNote, a dialog box will appear asking you 

whether you want to Open an existing library, or Create a new library - you'll 

need to select the option to Create a new library  

• You’ll be able to give your new library a memorable filename if you decide to 

change it from the default 

 

Slide Ten - Using your EndNote library 

The next few slides will be image-rich as there are a lot of screenshots to cover the 

different elements of EndNote and what functions you can expect to find where. 

 

Slide Eleven - EndNote’s ‘look and feel’ 

This section will focus on how EndNote looks, what the different sections are and will 

briefly cover what those sections help you do. 
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We will not be going into detail as that will come in future workshops. 

 

Slide Twelve - Screenshot of an EndNote Library’s main screen 

EndNote’s home page has four (4) sections 

1. Central section to display brief references 

2. Action tabs on the upper left of the page (running from left to right) 

3. Action icons on the upper right of the page (running from left to right) 

4. Resources in left-hand sidebar 

Only some of these items will be covered in this presentation. Ones which aren’t 

covered will be gone over in the intermediate presentations. 

 

Slide Thirteen - Screenshot of the middle section of the EndNote screen 

1. Central section of the screen to display brief references 

i. Gives you a brief look at the items in the selected folder depending on the 

criteria that you have selected for display. 

ii. Default criteria are attachment, author, year, title of the item, journal title (if 

it’s an article record), reference type (e.g., article). 

iii. If you open the reference (by double-clicking) information will display on 

the right-hand side of the screen. You will see the reference information, a 

tab to edit the content and add data which may be missing e.g., page 

numbers, or volume/ issue, and a tab to view the PDF (if attached) of the 

item. You will also be able to open the PDF in a new window so that you 

can have a better viewing experience. 
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Slide Fourteen - Action tabs on the upper left of the page (running from 

left to right) 

i. File 

ii. Edit 

iii. References 

iv. Groups  

v. Library 

vi. Tools 

vii. Window 

viii. Help 

 

Slide Fifteen - Action icons on the upper right of the page (running from 

left to right) 

i. Insert a citation for each selected reference 

ii. Add a new reference to the selected group 

iii. Share this group 

iv. Export references to another file or library 

v. Search the web for full-text documents for the selected references 

vi. Create a Web of Science Citation report from the selected references 

 

Slide Sixteen - Resources in left-hand sidebar 

i. Sync [Synchronise Configuration] 

ii. All References 
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iii. Recently Added 

iv. Unfiled 

v. Trash 

vi. My Groups 

vii. Find Full Text 

viii. Groups Shared 

ix. Online Search 

 

Slide Seventeen - A closer look 

Over the next couple of slides, we’ll be looking at some elements of some of the action 

buttons on the top-left of the EndNote home page. 

Remember, elements not covered here may be in subsequent workshops. 

 

Slide Eighteen - The File tab 

There are quite a few items visible in this screenshot of the options under the file tab, 

but the only ones to mention here are the following: 

• Close Library 

• Save a Copy 

• Import – either a file or a folder containing multiple PDF files 

These are the three that you are most likely to use starting out. 

• Close library is self-explanatory; it’s a good idea to close your library before 

exiting out of the programme. 

• Save a copy is a useful option, especially if you’re adding lots of references to 

EndNote, as this will create a backup so that if your original file becomes 
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corrupted or otherwise inaccessible you will have the copied version to fall back 

on. 

• And finally, the Import function – one of the most key tools you will use in 

EndNote.  

• The Import File option lets you either add a collection of references which you’ve 

exported from one of our databases as e.g., an RIS file1, or you can import 

individual PDFs.  

• The Import Folder option lets you import multiple PDFs at a time if they’re saved 

in the same folder. 

 

Sometimes you may find page numbers or issue numbers missing after you’ve 

imported something, and it’s better to correct this when you first add the article to 

EndNote rather than having to do it in a rush as you’re creating your reference list. 

 

Slide Nineteen - The Edit tab 

Under the edit tab the key features are to change the appearance of EndNote and the 

text of the records you store there and, most important, the preferences option.  

This is something we’ll come back to later in the setting up section of the workshop. 

 

Slide Twenty - The References tab 

There are several elements on this tab but key ones to mention are the options of 

creating a New Reference – this would be manually creating it by filling out a record for 

whichever item you want to add to EndNote. 

 
1 RIS stands for Research Information Systems – essentially the name of the 

company which developed the file format. 
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The Copy References To option is if you want to copy your references into a second, 

pre-existing library or into a new library that you create there and then. 

The Find Full Text option will be very important once you’ve gone through your articles 

and decided which ones to keep as it will do a lot of the heavy work of finding full-text 

links and PDFs in our library subscriptions and attaching them to the relevant records. 

This option will be covered in more detail in another workshop. 

 

Slide Twenty-One - The Groups tab 

When you’re doing research, one of the most important things you need to do is stay 

organised. Just adding your references to EndNote isn’t enough to keep organised, 

especially if you’re searching more than one database and need to fill out a PRISMA 

flow diagram and record your search process. 

You can manually Create a Group and name it whatever you want, which is 

recommended if you’re going to e.g., put the records from database search 1 into a 

group, and then the records from database search 2 into another group. 

You can also use the Create Group Set option to create a group which holds sub-

groups. So, you could have a Group Set called, ‘Database Results’, and then within that 

group set have individual groups for each database you’ve searched e.g., Cinahl, 

Embase, Scopus, British Education Index, ACM Digital Library; or you could have sub-

groups covering particular themes, or articles to use for specific assignments. You can 

arrange them however you feel would be most useful and keep you organised. 

 

Slide Twenty-Two - The Tags tab 

The Tags tab is a new feature in EndNote 21 and allows you to add a little more 

(visible) information to an item record which you can have displayed in the central panel 

along with the other, brief article information.  
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How to use this feature will be covered in the live workshops. 

 

Slide Twenty-Three - The Library tab 

Sync 

With the desktop version of EndNote, you can also connect to the web version so that 

you can easily work away from your main device, add references ‘on the go’ via the web 

interface and then, when you get back to your main device, Synchronise your libraries 

so that any changes you made will show up in both resources – desktop and online 

EndNote. 

You can only sync one library at a time so if you’ve created multiple libraries for different 

projects (not necessary, but you may have decided to do that), then you will have to 

choose which one to synchronise with the web-based version. 

Advanced Search 

The Advanced Search option can be used when your library has a lot of content and 

you want to find a specific paper, or group of papers, and you haven’t used the Tags 

feature to organise them. Advanced search only looks within your library, it doesn’t find 

new articles for you. 

Find and Replace 

Find and Replace can be used when you want to make bulk changes to a lot of 

records. You may want to change the type, or tag, and so on. If you do decide to use 

this option on many records, make sure that you back your library up first. Then if 

you’ve made a mistake, or you change your mind, you can easily return to a previous 

version of your library. 
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Slide Twenty-Four - The Tools tab 

Install EndNote Click 

EndNote Click is a free browser plugin that finds the best available PDF of an 

academic article while you browse. Behind the scenes, EndNote Click will 

search open databases and (where possible) your university's subscriptions to 

find the best version of the paper for you.2 

To install, go to Tools and select Install EndNote Click Browser Extension from the 

drop-down list.  

Then follow the instructions on screen to add the extension to the browser you’re using. 

 

Output Styles 

Output styles are the referencing style you want your references to be in when you use 

the Cite While You Write function. There are a few pre-installed in EndNote and you can 

add many more if the referencing style you’re going to use isn’t initially listed. 

If you’re using the Harvard style of referencing, you will need to install the correct output 

style so that your references look correct. This will be covered in one of the live 

workshops. 

 

Cite While You Write [CWYW] 

When you install EndNote, it should automatically add an EndNote toolbar to Word so 

that you can use the Cite While You Write function. 

 
2 Clarivate (2023) EndNote Click: What is EndNote Click and how do I use it? Available at:  
https://support.clarivate.com/Endnote/s/article/EndNote-Click-What-is-EndNote-Click-and-how-do-I-use-
it?language=en_US (Accessed: 19 September 2023) 
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This will enable you to write your work: essay, article, presentation notes, dissertation 

etc., and add citations and references directly from your EndNote library as you go 

along. 

Because it will add exactly what’s there, you need to make sure that EndNote has the 

correct information harvested from article PDFs or from the records imported from 

databases, as correcting it when you’re already writing up can be time-consuming. 

 

Online Search 

It is possible to search a number of databases from within EndNote to locate specific 

references to add to your library – so not to do a formal, topic search but to look for a 

particular article and so on. 

In the left-hand menu you may see PubMed or Web of Science already included as 

locations to search in. It’s possible to add additional databases to the list, but not 

everything we subscribe to at the university library can be added or accessed in this 

way. 

It should be emphasized however, that it is strongly recommended to search in the 

databases themselves. 

 

Slide Twenty-Five - Questions? 

If you have any questions about the content of these slides, then you can get in touch 

with our library enquiries team by or by using the live chat feature on any of our library 

pages (bottom right of the screen) 

Library Enquiries 

Email: library@derby.ac.uk  / (01332) 59 1215 

 

Develop@Derby Hub 

mailto:library@derby.ac.uk?subject=Problem%20using%20EndNote
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https://libguides.derby.ac.uk/develop-at-derby 

 

There will be some EndNote Introductory II workshops building on this content in the 

Library Workshops events calendar so make sure you have a look and sign up for 

relevant sessions. Intermediate level sessions will also be available. 

Library Workshops 

https://libcal.derby.ac.uk/ 

 

Research skills help 

https://libguides.derby.ac.uk/researchguides 

 

You can also find support and help resources on Clarivate’s EndNote pages via the link  

EndNote Support (Clarivate) 

https://support.clarivate.com/Endnote/s/?language=en_US 

 

Slide Twenty-Six - Thanks for watching 
This slide only has a cartoon image of a person saying Thanks 

https://libguides.derby.ac.uk/develop-at-derby
https://libcal.derby.ac.uk/
https://libguides.derby.ac.uk/researchguides
https://support.clarivate.com/Endnote/s/?language=en_US
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